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1 An Introduction to Database Publishing
Database publishing is the process by which information is automatically 
taken from one or more data sources—including any number of databases, 
flat files, and images—and assembled into a complete document. Examples 
of publications produced by database publishing include directories, 
catalogs, price lists, invoices, financial statements, and reports. This chapter 
is written for those individuals beginning the process of publishing 
information from a database. It explores different methods of retrieving data 
(both static and dynamic) and publishing data with FrameMaker.

Automated Tagged 
Publishing vs. 
Data-Driven 
Publishing

Database publishing can be segregated into two broad categories—
automated tagged publishing and data-driven, dynamic publishing. What’s 
the difference? Automated tagged publishing is the process by which a flat 
file (basically a big text file with special markups or tags in it) is parsed and 
published with FrameMaker. Data-driven publishing is the process by which 
data is retrieved (in real time) from the database and published (in real time) 
into FrameMaker—there is no need for an intermediary markup language or 
text file. Although automated tagged publishing solutions are partially data-
driven (e.g., they decide what to publish based on values in the tagged file 
they are parsing), the entire process is not data-driven.

There are many applications on the market that claim to be data-driven 
publishing solutions when, in fact, they are nothing more than sophisticated 
flat-file parsers. Many database publishing applications do not communicate 
directly with a database when they publish. Many use an intermediary 
markup language that the application parses when they publish. In other 
words, a markup file such as MML, XML, or MIF needs to be created from 
the database. Then the database publishing application parses the markup 
file and “publishes” the information. Automated publishing with 
FrameMaker can be done with MML, MIF, XML, Miramo, or Unimerge.

d
With the release of FrameMaker 7, the desktop version of FrameMaker is not licensed 
for entirely-automated, server based publishing. FrameMaker Server 7.0 has the same 
technology as the desktop version of FrameMaker but has a license for use in server-
based solutions. See Adobe’s website for more information about FrameMaker Server 
7.0 and download their white paper on database publishing.
pyright © 1998 - 2009 Beyond Print Incorporated
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Database 
Publishing 
Applications

There are many applications on the market for database publishing. The 
following database publishing applications work (at some level) with 
FrameMaker.

Data-Driven Publishing Applications
• BookDB from Sabern—

www.sabern.com/eng/index.htm?show=bookdbxml.htm

• CatBase from CatBase Software Ltd.—www.catbase.com

• Catalogger from Guidance—www.guidance.nl/en/page/catalogger-
framemaker

• FrameScript® from Finite Matters Ltd.—www.framescript.com

• PatternStream® from Finite Matters Ltd.—www.patternstream.com

Automated Tagged Publishing Applications
• Miramo from Datazone Ltd.—www.miramo.com

• Unimerge from Refined Reports—No Web site available

Variable Printing Applications
• DL Pager from Datalogics—

www.datalogics.com/products/pager/pager.asp

Author’s Choice The author has been involved with database publishing for many years. After 
evaluating the tools on the market, he chose PatternStream as his preferred 
database publishing solution. In addition to PatternStream, he also uses 
FrameScript for very simple database publishing projects (like the example 
used in this chapter). In 2004, the author joined the Finite Matters Ltd.’s team 
full-time and continues to provide automated publishing solutions with 
PatternStream.

The examples in this chapter will give you a representative idea of what is 
involved in database publishing. Even though a couple of examples refer to 
specific database publishing applications, this chapter is not meant to 
endorse any particular database publishing application or solution. There is 
not enough room to lay out a step-by-step example for each product.
Copyright © 1998 - 2009 Beyond Print Incorporated
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1 The Cost of Setting Up the Initial Database Publishing System
The costs involved in a database publishing project can be hard to quantify. 
Many (if not most) companies fail to understand or are unable to quantify the 
costs involved. Many software vendors selling database publishing solutions 
are not clear on what additional costs are involved other than the software 
they are selling. The costs involved in database publishing encompass more 
than just the software, and will be the highest up front. Once the system is in 
place, the savings resulting from the now-automated process should pay for 
the initial setup costs very quickly (see Table 1). 

Setting up the 
Database

The first cost in database publishing is the cost of the database itself. This 
step is the most important to consider as it will affect the ease of publishing 
and the actual content of your final product. Setting up and populating the 
database will comprise 40%–60% of the time necessary to set up a database 
publishing solution. This could be the most costly part of the project as 
well—usually involving a database administrator. Setting up the database can 
be the most important step in any project. The structure of the database will 
determine the flexibility with which the data is retrieved or output.

Before you can set up the database, you need to answer some questions:

• Who will set up the database structure and populate the data?

• Will you use an off-the-shelf solution (such as CatBase) or will you set up 
a custom database solution with a database such as Microsoft Access, 
FileMaker Pro, SQL Server, MySQL, SyBase, DB2, or Oracle, along with 
possible flat files such as Microsoft Excel spreadsheets, XML or ASCII?

• How many people will be involved in setting up the database and 
populating it?

• How much time will this take?

Table 1 – High-Level Project Steps and Time Requirements

High-Level Project Steps Percentage of Time

Setting up the database 30%–60%

Getting information from the database to publish 10%–30%

Setting up the publishing application 10%–40%

On-going Support 0%–20%
pyright © 1998 - 2009 Beyond Print Incorporated
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Getting 
Information from 
the Database to 
Publish

Getting the data from the database and putting it in the desired order and 
format is the next big budget hurdle in a database publishing project. Before 
you start, you’ll need to answer some more questions:

• How will you get the data to FrameMaker for publishing? 

• Will you “dump” the data from the database in a markup language such as 
MML, XML, MIF, or some other markup language that then needs to be 
run through another database publishing application that understands 
the markup and then output in Frame? 

• Will the database be queried directly and the data pushed into 
FrameMaker on the fly? 

If the data is “dumped” into a markup file, the initial cost involved is usually 
more because a database administrator is usually required. If the data is 
directly queried from the database, the costs are usually lower because the 
database administrator is only needed to answer occasional questions from 
the publishing staff person performing the queries during the initial setup. 
After the initial setup using either technique, the only further cost will be for 
executing the queries. The time requirement for getting the initial data 
(writing the SQL queries and/or reports) will be 10%–30% of the project.

Setting up the 
Publishing 
Application

The next step in database publishing is setting up the publishing application. 
This step includes designing the final FrameMaker templates, getting the 
data (whether directly from the database or from static markup files), and 
putting the data into the template. This step will comprise 10%–30% of the 
time required to complete the project.

Here are some questions you’ll need to answer before you set up the 
publishing application: 

• Are you using a solution that will need to parse markup files generated 
from the database? 

• Are you using a solution that will query the data directly from the 
database? 

• Will you design the FrameMaker templates yourself?
Copyright © 1998 - 2009 Beyond Print Incorporated
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Ongoing Support The final cost to consider when starting a database publishing project is the 
cost of ongoing support. In order to choose your method of ongoing support, 
you need to answer these questions: 

• What will future editions of your project cost? 

• How often will you need to upgrade the software/hardware involved?

• Will you need further support from a database administrator to build 
custom queries? 

• Will you need to maintain a support contract on the software or process 
you are using? 

• What is the cost of keeping your employee(s) current in the software used 
versus outsourcing the publishing?

When considering the cost of implementing a database publishing project, 
make sure to consider all of these costs and not just a single cost (such as the 
price of software). The cost of the software may only be a small portion of the 
total cost of the project.
pyright © 1998 - 2009 Beyond Print Incorporated
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Figure 1 Directory page sample.
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U-HAUL RENTAL SYSTEM

1325 Airmotive Way

Reno, NV 89502–3201

Phone (702)-688-6300

Edward J Shoen . . . . . . . . . . . . . . . . . . . . . . . . . . Ch Bd Pr

Gary V Klinefelter. . . . . . . . . . . . . . . . . . . . . . . . . Sec GC
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Phone (305)-871-1587

Rustem Kupi . . . . . . . . . . . . . . . . . . . . . . . . . . . . . Pr

SIC 4512, 8741: air passenger carrier, scheduledmanagement ser-

vices.

F-M-L 849284526

 

AMERICA K INTERNATIONAL INC

 

2 Mott St
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Stephen Kong. . . . . . . . . . . . . . . . . . . . . . . . . . . . Ch

SIC 8742: new business start-up consultant.

F-M-L 624877056

 

AMERICA SERVICE GROUP INC

 

2 Penns Way Ste 200

New Castle, DE 19720–2407

Phone (302)-322-8200

Scott L Mercy . . . . . . . . . . . . . . . . . . . . . . . . . . . . Pr CEO

Stuart H Shapiro MD  . . . . . . . . . . . . . . . . . . . . . COO Ex VP

Michael Catalano. . . . . . . . . . . . . . . . . . . . . . . . . Ex VP Sec

Tom Burns Jr . . . . . . . . . . . . . . . . . . . . . . . . . . . . . Asst Tr Cont

Robert L Bowen . . . . . . . . . . . . . . . . . . . . . . . . . . VP

Ronald O Miller  . . . . . . . . . . . . . . . . . . . . . . . . . . VP

Margaret O Harrison  . . . . . . . . . . . . . . . . . . . . . VP Fin Admn

SIC 5047, 5961, 8011: medical equipment & suppliespharmaceu-

ticals, mail orderoffices & clinics of medical doctors.

F-M-L 824739668

 

AMERICA WORKS OF NEW YORK INC

 

575 8th Ave 14th Fl

New York, NY 10018–3011

Phone (212)-244-5627
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SIC 7361: employment agencies.
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BEST INNS OF AMERICA

1205 Skyline Dr

Marion, IL 62959–5202

Phone (618)-997-5454

Harold D Smith. . . . . . . . . . . . . . . . . . . . . . . . . . . VP

SIC 7011: motel, franchised.

F-M-L 793096934

 

AMERICA'S FINEST SERVICE CO INC

 

407 D Parkway Dr

Greensboro, NC 27401

Phone (910)-379-0156

Wynetta Peters. . . . . . . . . . . . . . . . . . . . . . . . . . . Pr

Robert Peters  . . . . . . . . . . . . . . . . . . . . . . . . . . . . VP

SIC 7349: cleaning service, industrial or commercial; maid ser-

vices, contract or fee basis.

F-M-L 188750889

 

AMERICA'S RENT-TO-OWN CENTER INC

 

T

 

RADE
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AMERICA'S SALES & LEASING

11 N Highland St

Chanute, KS 66720–1853

Phone (316)-431-2020

Gary Clay . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . Pr

W Frank Springer. . . . . . . . . . . . . . . . . . . . . . . . . Ex VP

Jackie Clay . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . Sec Tr

SIC 7359: furniture rental; electronic equipment rental, except 

computers; appliance rental.

F-M-L 878517747

 

AMERICAID INC
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AMERICAID COMMUNITY CARE

4425 Corporation Ln

Virginia Beach, VA 23462–3103

Phone (804)-449-6900

Jeffrey Mc Waters  . . . . . . . . . . . . . . . . . . . . . . . . Pr

Denna Ferrante . . . . . . . . . . . . . . . . . . . . . . . . . . CFO

SIC 8011: health maintenance organization.

F-M-L 118196997

 

AMERICALL CORP

 

730 Springer Dr

Lombard, IL 60148–6411

Phone (630)-620-4355

George A Kestler . . . . . . . . . . . . . . . . . . . . . . . . . Pr

SIC 7389: telemarketing services.

F-M-L 861437762

 

AMERICAN ACADEMY & INSTITUTE OF HUMAN 
REASON INC

 

T

 

RADE

 

 N

 

AME

 

TAMPA BAY RETIREMENT CENTER

11722 N 17th St

Tampa, FL 33612–5434

Phone (813)-971-8072

Jack Smith . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . Pr

Frances Cooper . . . . . . . . . . . . . . . . . . . . . . . . . . Sec

Donald Hentschel . . . . . . . . . . . . . . . . . . . . . . . . Tr

Clement De Wall . . . . . . . . . . . . . . . . . . . . . . . . . VP

Ilene Maddin. . . . . . . . . . . . . . . . . . . . . . . . . . . . . VP

Mary Murphy . . . . . . . . . . . . . . . . . . . . . . . . . . . . VP

Anne Markarian. . . . . . . . . . . . . . . . . . . . . . . . . . Admr

SIC 8361: home for the aged.

F-M-L 088551429
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DRAIN PATROL

2400 Lindberg St

Auburn, CA 95602–9061

Phone (916)-888-8114

Chester Eccles  . . . . . . . . . . . . . . . . . . . . . . . . . . . Pr

Ingrid Eccles . . . . . . . . . . . . . . . . . . . . . . . . . . . . . Sec

Christina Eccles  . . . . . . . . . . . . . . . . . . . . . . . . . . Asst Sec

Tracy Percival . . . . . . . . . . . . . . . . . . . . . . . . . . . . Off Mgr

SIC 7699: sewer cleaning & rodding.

F-M-L 868594482

 

AMERICAN ALPHA DATA CORP

 

1006 N Bowen Rd Ste 201

Arlington, TX 76012–2868

Phone (817)-276-6950

Joseph G Rio . . . . . . . . . . . . . . . . . . . . . . . . . . . . . Pr

SIC 7374: data processing service.

F-M-L 838094811

 

AMERICAN ALPHA DISPATCH SVCS

 

225 Main St
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Phone (516)-845-7130

Sid Mandel  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . Pr

SIC 7374: data processing service.

F-M-L 095813523

 

AMERICAN ANALYTICAL SERVICES INC

 

110 Technology Pky S

Norcross, GA 30092–2908

Phone (770)-734-4200

Robert G Owens  . . . . . . . . . . . . . . . . . . . . . . . . . Pr

Wyn Jones . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . Sec Tr

Billy P Dyer  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . VP

Denise Geier . . . . . . . . . . . . . . . . . . . . . . . . . . . . . VP

SIC 8734: testing laboratories.

F-M-L 182824078

 

AMERICAN ANESTHESIA SERVICES INC

 

2065 E West Maple Rd

Walled Lake, MI 48390–3858

Phone (810)-960-3400

Al Simon. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . Pr CEO

Andy Terhune. . . . . . . . . . . . . . . . . . . . . . . . . . . . CFO

SIC 8099: medical services organization.

F-M-L 064992647

 

AMERICAN ARBITRATION ASSOCIATION INC

 

140 W 51st St

New York, NY 10020–1200

Phone (212)-484-4000

William K Slate II  . . . . . . . . . . . . . . . . . . . . . . . . . Pr CEO

John C Emmert Jr . . . . . . . . . . . . . . . . . . . . . . . . CFO Sr VP

Mark E Appel  . . . . . . . . . . . . . . . . . . . . . . . . . . . . Sr VP

Charles A Cooper . . . . . . . . . . . . . . . . . . . . . . . . Sr VP

George H Friedman . . . . . . . . . . . . . . . . . . . . . . Sr VP

Steven G Gallagher  . . . . . . . . . . . . . . . . . . . . . . Sr VP

Richard W Naimark. . . . . . . . . . . . . . . . . . . . . . . Sr VP

Florence M Peterson . . . . . . . . . . . . . . . . . . . . . Sr VP

Richard M Reilly. . . . . . . . . . . . . . . . . . . . . . . . . . Sr VP

Janice Wagner . . . . . . . . . . . . . . . . . . . . . . . . . . . Sec

Richard Devlin . . . . . . . . . . . . . . . . . . . . . . . . . . . Cont

Michael F Hoellering . . . . . . . . . . . . . . . . . . . . . GC

SIC 2721, 2731, 7389, 8299: periodicals: publishing onlybooks: 

publishing onlyarbitration & conciliation serviceeducational ser-

vices.

F-M-L 181786021

 

AMERICAN ASSAY LABORATORIES INC

 

1500 Glendale Ave

Sparks, NV 89431–5902

Phone (702)-356-0606

George Burke . . . . . . . . . . . . . . . . . . . . . . . . . . . . Pr

Chris Ioannakis  . . . . . . . . . . . . . . . . . . . . . . . . . . Sec Tr

Julie Allred  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . Cont

SIC 8734: testing laboratories.

F-M-L 066778077
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T

 

RADE
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AME

 

AARP

601 E St Nw

Washington, DC 20049–0001

Phone (202)-434-2277

Norman Stengel . . . . . . . . . . . . . . . . . . . . . . . . . Pr

Richard Henry  . . . . . . . . . . . . . . . . . . . . . . . . . . . COO

Clifford J Rose  . . . . . . . . . . . . . . . . . . . . . . . . . . . Cont

Steven S Zaleznick . . . . . . . . . . . . . . . . . . . . . . . GC

Horace B Deets  . . . . . . . . . . . . . . . . . . . . . . . . . . Ex Dir

James R Holland . . . . . . . . . . . . . . . . . . . . . . . . . Commctns

James A Maigret . . . . . . . . . . . . . . . . . . . . . . . . . Fin Plng

Charles W Allen . . . . . . . . . . . . . . . . . . . . . . . . . . Publs

Constance Swank . . . . . . . . . . . . . . . . . . . . . . . . Rsch

Thomas C Nelson . . . . . . . . . . . . . . . . . . . . . . . . Svcs

Wayne F Haefer . . . . . . . . . . . . . . . . . . . . . . . . . . Dir

C Anne Harvey. . . . . . . . . . . . . . . . . . . . . . . . . . . Dir

Mary Anne Riesenberg . . . . . . . . . . . . . . . . . . . Dir
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SIC 8399: health systems agency; social change association; 

social service information exchange.

F-M-L 028756187

 

AMERICAN AUTO SERVICE INC

 

T

 

RADE

 

 N

 

AME

 

AAS

11247 Burbank Blvd

North Hollywood, CA 91601–2466

Phone (818)-761-3220

Kerry Pedlow . . . . . . . . . . . . . . . . . . . . . . . . . . . . Pr

Kerry R Pedlow  . . . . . . . . . . . . . . . . . . . . . . . . . . Pr

Arthur H Atkins . . . . . . . . . . . . . . . . . . . . . . . . . . Ex VP

Joyce Pedlow . . . . . . . . . . . . . . . . . . . . . . . . . . . . Tr VP

Margo Atkins . . . . . . . . . . . . . . . . . . . . . . . . . . . . VP

SIC 7538: general automotive repair shops.

F-M-L 055353072

 

AMERICAN BANCORPORATION

 

1025 Main St Ste 800

Wheeling, WV 26003–2726

Phone (304)-233-5006

Jeremy C Mc Camic . . . . . . . . . . . . . . . . . . . . . . Ch Bd CEO

Paul Donahie . . . . . . . . . . . . . . . . . . . . . . . . . . . . Pr

Brent Richmond  . . . . . . . . . . . . . . . . . . . . . . . . . Sec Tr

SIC 6022, 6162, 7374: state commercial banksmortgage brokers, 

using own moneydata processing service.

F-M-L 020450680

 

AMERICAN BAPTIST ASSEMBLY INC

 

T

 

RADE

 

 N

 

AME

 

GREEN LAKE CONFERENCE CENTER

W2511 State Road 23 & 4

Green Lake, WI 54941–9542

Phone (414)-294-3324

Ken Giacoletto . . . . . . . . . . . . . . . . . . . . . . . . . . . Pr

SIC 7041, 7992: membership-basis organization hotelspublic 

golf courses.

F-M-L 076614767

 

AMERICAN BAPTIST ELDER MINISTRIES OF 
MASSACHUSETTS

 

1618 Chipman Way

Kingston, MA 02364

Phone (617)-585-5526

Rev Robert Wallace  . . . . . . . . . . . . . . . . . . . . . . Ch

SIC 8051, 8322, 8361: skilled nursing care facilitiesadult day care 

centergeriatric residential care.

F-M-L 074463282

 

AMERICAN BAPTIST ESTATES INC

 

T

 

RADE

 

 N

 

AME

 

ORANGEWOOD

7550 N 16th St

Phoenix, AZ 85020–4618

Phone (602)-944-4455

Dr Richard Ice. . . . . . . . . . . . . . . . . . . . . . . . . . . . Pr

David Ferguson . . . . . . . . . . . . . . . . . . . . . . . . . . Ex VP

Rev Steve Garner  . . . . . . . . . . . . . . . . . . . . . . . . Sr VP

Linda D Exner. . . . . . . . . . . . . . . . . . . . . . . . . . . . Admr

SIC 8051, 8059: skilled nursing care facilitiesrest home, with 

health care.

F-M-L 068175637

 

AMERICAN BAPTIST HOMES OF THE MIDWEST

 

11985 Technology Dr

Eden Prairie, MN 55344–3622

Phone (612)-941-3175

Lois Bohon  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . Ch Bd

Jack E Patty . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . Pr

Polly Schrom  . . . . . . . . . . . . . . . . . . . . . . . . . . . . Sec Tr

Noel Dikkers . . . . . . . . . . . . . . . . . . . . . . . . . . . . . Acctg

SIC 8051, 8052, 8361: convalescent home with continuous nurs-

ing care; mental retardation hospitalhome for the mentally 

retarded, with health carerest home, with health care incidental.

F-M-L 071691307

 

AMERICAN BAPTIST HOMES OF THE WEST INC

 

T

 

RADE

 

 N

 

AME

 

JENSEN PARK

400 Roland Way

Oakland, CA 94621–2012

Phone (510)-635-7600

Roy E Hughes . . . . . . . . . . . . . . . . . . . . . . . . . . . . Ch Bd

Richard E Ice . . . . . . . . . . . . . . . . . . . . . . . . . . . . . Pr CEO

David Ferguson . . . . . . . . . . . . . . . . . . . . . . . . . . Ex VP

Steven Garner  . . . . . . . . . . . . . . . . . . . . . . . . . . . Sr VP Admn

Marlene O Dixon. . . . . . . . . . . . . . . . . . . . . . . . . VP

Douglas W Howell  . . . . . . . . . . . . . . . . . . . . . . . VP

William C Nelson. . . . . . . . . . . . . . . . . . . . . . . . . VP

Sue Schock Roderick . . . . . . . . . . . . . . . . . . . . . VP

Margaret Weitkamp. . . . . . . . . . . . . . . . . . . . . . VP

George R Goupille  . . . . . . . . . . . . . . . . . . . . . . . VP Fin

SIC 8059: rest home, with health care.

F-M-L 180180630

 

AMERICAN BAPTIST HOMES OF WASHINGTON 
INC

 

T

 

RADE

 

 N

 

AME

 

JUDSON PARK RETIREMENT

23600 Marine View Dr S

Des Moines, WA 98198–7352

Phone (206)-824-4000

David B Ferguson . . . . . . . . . . . . . . . . . . . . . . . . Pr

George Goupille . . . . . . . . . . . . . . . . . . . . . . . . . VP Fin

Audrey Bowers  . . . . . . . . . . . . . . . . . . . . . . . . . . Dir

SIC 8051, 8059: skilled nursing care facilitiesconvalescent home.

F-M-L 058418567

 

AMERICAN BECHTEL INC

 

50 Beale St

San Francisco, CA 94105–1813

Phone (415)-768-1234

Riley P Bechtel . . . . . . . . . . . . . . . . . . . . . . . . . . . Ch Bd

Adrian Zaccaria . . . . . . . . . . . . . . . . . . . . . . . . . . Pr

John D Carter . . . . . . . . . . . . . . . . . . . . . . . . . . . . Sr VP

J P Laspa  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . Sr VP

Dean L Orcutt. . . . . . . . . . . . . . . . . . . . . . . . . . . . Sr VP

V P Unruh  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . Sr VP Tr

John W Weiser . . . . . . . . . . . . . . . . . . . . . . . . . . . Sr VP Sec

James Buenneke. . . . . . . . . . . . . . . . . . . . . . . . . Acctg

SIC 1629, 8711, 8742: industrial plant construction; power plant 

constructionconstruction & civil engineeringconstruction project 

management consultant.

F-M-L 804201572

 

AMERICAN BEHAVORIAL RESEARCH 
ASSOCIATION

 

1 West St

New Hyde Park, NY 11040–2315

Phone (516)-873-7000

Francis J De'lia PhD  . . . . . . . . . . . . . . . . . . . . . . CEO

John Hennessey PhD. . . . . . . . . . . . . . . . . . . . . CFO

Richard Jennings  . . . . . . . . . . . . . . . . . . . . . . . . Ex VP GM

Andrew Morrissey PhD. . . . . . . . . . . . . . . . . . . Ex VP

Thomas Grainger PhD. . . . . . . . . . . . . . . . . . . . Dir

SIC 8741: financial management for business.

F-M-L 157626094

 

AMERICAN BENEFIT CORP

 

401 11th St

Huntington, WV 25701–2218

Phone (304)-525-0331

Richard L Wilson . . . . . . . . . . . . . . . . . . . . . . . . . Pr CEO

Matthew W Carlton . . . . . . . . . . . . . . . . . . . . . . Ex VP

Kenneth L Joos  . . . . . . . . . . . . . . . . . . . . . . . . . . Sr VP

B Diane Mastin. . . . . . . . . . . . . . . . . . . . . . . . . . . Sec Tr

Barbara Booth . . . . . . . . . . . . . . . . . . . . . . . . . . . Cont

SIC 8742, 8748, 8999: human resource consulting servicesem-

ployee programs administrationactuarial consultant.
Copyright © 1998 - 2009 Beyond Print Incorporated
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1 Publishing a Simple Directory from a Database
Figure 1 is a sample page from a large directory published from a relational 
database. In this example you will see the decisions that need to be made 
when you embark on a database publishing project. Although most database 
publishing projects are much more complex than this and include items such 
as images and tables, this examples gives a basic idea of what is involved in 
database publishing and the approach you should use for your project.

Determining the 
Output of a 
Directory Listing

Now take a closer look at one of the directory entries from this sample. At 
first glance, the entry looks fairly easy and straight-forward. We are 
outputting a company’s FML number, name, trade name, address, city, state, 
pyright © 1998 - 2009 Beyond Print Incorporated
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zip+5, zip+4, phone number, list of executives and his/her titles, SIC 
number(s), and SIC description(s). Each of these items has a particular 
paragraph style associated with it (see Figure 2).

Now take a closer look at the decisions that need to be made for each entry:

• Does the company have a trade name? If so, output it. If not, don’t output 
the default text “Trade Name” or the paragraph allocated for it.

• Does the company have a zip+4 code? If so, output the zip+5 and the 
zip+4 with an en dash in between them. If not, output only the zip+5 
without the en dash. 

Figure 2 Sample entry from directory.

AMERICAN ASSOCIATION OF RETIRED 
PERSONS

TRADE NAME AARP

601 E St Nw

Washington, DC 20049–0001

Phone (202) 434-2277

Norman Stengel . . . . . . . . . . . . . . . . . . . . . . . . . Pr

Richard Henry  . . . . . . . . . . . . . . . . . . . . . . . . . . . COO

Clifford J Rose  . . . . . . . . . . . . . . . . . . . . . . . . . . . Cont

Steven S Zaleznick . . . . . . . . . . . . . . . . . . . . . . . GC

Horace B Deets  . . . . . . . . . . . . . . . . . . . . . . . . . . Ex Dir

James R Holland . . . . . . . . . . . . . . . . . . . . . . . . . Commctns

James A Maigret . . . . . . . . . . . . . . . . . . . . . . . . . Fin Plng

Charles W Allen . . . . . . . . . . . . . . . . . . . . . . . . . . Publs

Constance Swank . . . . . . . . . . . . . . . . . . . . . . . . Rsch

Thomas C Nelson . . . . . . . . . . . . . . . . . . . . . . . . Svcs

Wayne F Haefer . . . . . . . . . . . . . . . . . . . . . . . . . . Dir

C Anne Harvey. . . . . . . . . . . . . . . . . . . . . . . . . . . Dir

Mary Anne Riesenberg . . . . . . . . . . . . . . . . . . . Dir

Johc C Rother. . . . . . . . . . . . . . . . . . . . . . . . . . . . Dir

Jan Stefanov. . . . . . . . . . . . . . . . . . . . . . . . . . . . . Dir

SIC 8399: health systems agency; social change association; 

social service information exchange.
Copyright © 1998 - 2009 Beyond Print Incorporated
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• Does the company have a phone number? If so, format the phone number 
as (###) ###-#### and output it. If not, don’t output the paragraph 
allocated for it.

• Does the company have any executives listed? If so, output each of them 
in a separate paragraph. If not, don’t output the paragraph(s) allocated for 
them.

• If the company has executives, does the executive have a title? If so, output 
the executive’s name along with a tab and the executive’s title. If not, 
output only the executive name without the tab (so you’re not left with a 
leader and no text following it).

• Does the company have any SIC codes? If so, how many? If one, output 
the SIC code (with a character format applied to make it red) followed by 
a colon. If more than one, output each SIC code (with a character format 
applied to make it red) with a comma in between each SIC code. The last 
SIC code should be followed by a colon.

• If the company has one or more SIC codes, how many SIC descriptions 
does the company have? If one, output the description followed by a 
period. If more than one, output each SIC description followed by a 
semicolon, except for the last description, which should be followed by a 
period.

• One item that is not visible to the naked eye is the index marker for the 
company name that gets outputted with the company name.

• In what order do the entries appear? Alphabetically or in a special 
sequence?

Now that you’ve looked at output and the desired layout and data, you need to 
look at the actual database structure to see how the data is organized and how 
to access it. We will now look at the database structure and introduce the 
structured query language (SQL) that will be used to request the data from 
the database.
pyright © 1998 - 2009 Beyond Print Incorporated
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2 Relational Database Structure
The database used for the examples shown in this chapter uses a relational 
database structure (some of the new document repositories use an object-
oriented or XML/SGML data structure). This simply means that the data is 
divided and stored in separate locations in the database to keep the data from 
being repeated. For example, if you had a database of customers and kept 
track of each order that was placed by each customer, you could store the data 
in two manners. You could reenter the customers’ contact information 
(address, phone number, etc.) along with each order. Or you could keep the 
customers’ contact information in one location, the orders in another, and 
use a customer number to “relate” the contact information to the order 
information.

Database Tables In this example, the database used to generate the directory is a simple 
Access database. It contains three tables—Firms, Executives, and 
SIC_numbers. These three tables are related to each other by the ID field 
called FML_Number. In other words, each record in each table will have an 
FML_Number—this allows the executives and SIC information to be 
associated with the appropriate firm.

Firms Table
The Firms table contains company information such as the company name, 
trade name, street address, city, state, zip5, zip4, and phone number. Notice 
the FML number 066778077 for the highlighted AARP entry. This is the 
number used to related the entries in the next two tables (see Figure 3).

Figure 3 Firms table in Access.
Copyright © 1998 - 2009 Beyond Print Incorporated
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Executives Table
The Executives table contains the executive names and titles, and the 
sequence in which the names should appear. Notice that the highlighted 
executives all have the FML number 066778077 to associate these names 
with AARP (see Figure Figure 4). 

Figure 4 Executives table in Access.
pyright © 1998 - 2009 Beyond Print Incorporated
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SIC_numbers Table
The final table contains the SIC numbers and descriptions for each firm. The 
FML number 066778077 associates the SIC number and descriptions to the 
AARP entry.

Figure 5 SIC_numbers table in Access.
Copyright © 1998 - 2009 Beyond Print Incorporated
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2 Writing SQL Queries

Introduction to 
SQL

To communicate with a database, the most commonly used method is the 
structured query language (SQL). SQL (pronounced “sequel”) statements are 
issued to the database to return the desired data. A general SQL statement 
looks like the following:
SELECT <<field(s)>> FROM <<table(s)>> 

This statement simply tells the database to select one or more fields from a 
particular table in the database. For example, if the following SQL statement 
is issued:
SELECT Name FROM firms

the database will return a list of all company names in the database. A 
complex SQL statement looks like this:
SELECT <<DISTINCT>> <<field(s)>> FROM <<table(s)>>
WHERE (<<some value>> <<(= <> > <)>> <<some value>>)
ORDERBY <<field(s)>> 
GROUPBY <<field(s)>>

The added options in the SQL statement allow you to further limit, order, and 
group the returned data. 

Nested Queries When you use a data-driven publishing application, queries can be “nested.” 
This means that a second query can be run “inside” the first query to return 
information based on the first query. The example shown here uses a total of 
four queries to produce the final directory. The first query returns the 
company information. The second and third queries are run as subqueries to 
the first—they are nested in the first query. The second query returns the 
executive information for the company. The third query returns the SIC 
numbers for the company. The fourth query is a sub-subquery that is nested 
under the third query. The fourth query returns the SIC descriptions for each 
SIC number for each company. 

Queries Used in the 
Example

Firm Query
The Firm query returns one record for each company in the Firms table, 
along with the company name, phone number, street address, FML number, 
trade name, 5-digit zip code, 4-digit PO box number, state, and city:
pyright © 1998 - 2009 Beyond Print Incorporated
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SELECT Name, Phone, Street, FML_Number, TradeName, 
ZipCode_5Digit, ZipCode_4Digit, State, City
FROM firms

This query returns a data value for each field named after the select 
statement from the table named Firms in the database. It will return each of 
the values for every company in the Firms table.

Executive Query
The Executive query is run as a subquery to the Firm query. It returns every 
executive with his/her title from the Executives table. The executives are 
limited to the previously selected company in the Firm query by the FML 
number from the firm query. The records are ordered by the values in the seq 
column.
SELECT exec, title
FROM executives
WHERE FML_Number = :FML Number 
ORDER BY seq

This query returns an executive name and his/her title from the table named 
Executives for the particular company (matching the FML_Number) 
returned in the Firm query.

SIC Query
The SIC query is run as a subquery to the Firm query. It returns every SIC 
number limited to the previously selected company in the Firm query based 
on the FML number from the Firm query:
SELECT DISTINCT sic
FROM sic_numbers
WHERE FML_Number = :FML Number

This query returns all SIC numbers from the table named SIC_numbers for 
the particular company (matching the FML_Number) returned in the Firm 
query.

SIC Description Query
The SIC Description query is run as a subquery to the SIC query. It returns 
every SIC description for each SIC number. It is limited by the FML number 
returned in the Firm query and the SIC number returned in the SIC query.
SELECT descr
Copyright © 1998 - 2009 Beyond Print Incorporated
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FROM sic_numbers
WHERE (FML_Number = :FML Number and SIC = :SIC Number)

This query returns the SIC description from the table named SIC_numbers 
for each SIC number returned in the SIC query.

Now that you’ve constructed the queries needed to retrieve the desired data, 
you need to execute the queries to output the data.
pyright © 1998 - 2009 Beyond Print Incorporated
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2 Retrieving the Data from the Database
Retrieving the data from the database can be done in two different manners. 
The SQL queries can be executed from within the database application and 
the data can be “dumped” into an ASCII (text) file, or the queries can be 
executed from an external program via open database connectivity (ODBC).

Dumping the Data 
from the Database

Executing the SQL queries from within the database will result in the data 
and any markup being written to a file on the hard drive. This file is then 
post-processed during publishing. This data dump becomes a “snapshot” of 
the database at the time the queries were executed.

Connecting to the 
Database via ODBC

ODBC is a commonly used protocol for connecting to a database. When you 
use ODBC, a database is made available to the operating system. Any ODBC-
compliant application can then retrieve information from the database. 
FrameMaker is not natively ODBC compliant—in other words, it does not 
have a mechanism to connect to and communicate via ODBC. A third-party 
product is necessary to query information from a database into FrameMaker, 
or the data must be generated by the database for importing into 
FrameMaker. Most database publishing applications on the Mac and in 
Windows support ODBC database connectivity and can be used with 
FrameMaker for database publishing. To set up an ODBC connection, see 
Setting Up an ODBC Database Connection. 

The external application can then communicate with the database and 
execute the SQL queries to retrieve the data. The data can then be outputted 
to a file on the hard drive or sent directly into FrameMaker for publishing.

Setting Up an 
ODBC Database 
Connection

In the examples on the following pages, you will connect to an Access 
database via ODBC. To make this database available, you need to make the 
database available to the operating system via ODBC.

d You can have this database and ODBC connection automatically setup and installed if 
you download and install the demo version of PatternStream available at 
www.patternstream.com.
Copyright © 1998 - 2009 Beyond Print Incorporated
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1. In Windows 2000, XP, Vista, or 7 select 
Start>Programs>Administrative Tools>Data Sources (ODBC). (In 
Windows 95 or 98, the ODBC data sources can be found under 
Start>Settings>Control Panels.)

2. Click on the System DSN tab.
pyright © 1998 - 2009 Beyond Print Incorporated
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3. Click Add....

4. Select Microsoft Access Driver (*.mdb).

5. Click Finish.

6. Enter PS_SimpleDirectory under Data Source Name.
Copyright © 1998 - 2009 Beyond Print Incorporated
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7. Click the Select... button.

8. Navigate to the Access database entitled SimpleDirectory.mdb.

9. Click OK.
pyright © 1998 - 2009 Beyond Print Incorporated
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10. Click OK.

11. Click OK.

The SimpleDirectory database is now available via ODBC. A connection is 
made using the data source name—in this case PS_SimpleDirectory—and a 
username and password. The default username for an Access database is 
admin and there is not a password.
Copyright © 1998 - 2009 Beyond Print Incorporated
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1 Examples of Database Publishing with FrameMaker
The examples in this section of database publishing project will explore five 
different methods of database publishing with FrameMaker. First you will 
look at database publishing with PatternStream—a tool that allows you to set 
up the entire publishing system with a graphical user interface. Next, you will 
set up the same project using FrameScript. The last three examples show how 
database publishing is done with markup languages; you’ll see how to publish 
using MML, XML, and MIF.
pyright © 1998 - 2009 Beyond Print Incorporated
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3 Data-Driven Publishing with PatternStream™
PatternStream is a plug-in to FrameMaker that communicates directly with 
one or more databases (either natively or via an ODBC connection) and/or 
flat files (such as Excel, HTML, Word, or FrameMaker documents) to retrieve 
data, insert the data into a FrameMaker document, and format the data on 
the fly. No intermediary markup files are necessary for publishing. 
Prototyping is a very rapid process because changes can be made and 
samples can be run interactively as the data is outputted directly to 
FrameMaker.

PatternStream’s graphical user interface (GUI) allows even a newcomer to 
database publishing to develop with ease. PatternStream is a great tool for 
rapid prototyping and development for any database publishing project. The 
instructions provided in this book highlight the ease of setting up a database 
publishing project from a GUI. 
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2 Directory Example Using PatternStream

Introduction The following is a fairly complete step-by-step guide to setting up the 
directory example used in this chapter in PatternStream.

Data Link The Data Link folder of the PatternStream interface allows you to set up one 
or more connections to a database, construct the queries to retrieve the data, 
and create variables to store the retrieved data.

Building a Database Connection
To build a connection to the database, do the following:

1. Right-click in the Data Connections window and choose New Object.

2. Select ODBC from the Type drop-down list.

3. Name the data connection Simple Directory.

4. Click OK.

Figure 6 PatternStream’s Data Link folder.
pyright © 1998 - 2009 Beyond Print Incorporated
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5. Type in the ODBC data source name that was created in the 
“Connectiong to the Datebase via ODBC” section in Chapter 14.

6. Enter the database user ID—the user ID in Access is always admin by 
default.

7. Enter the database password—the database password in Access is 
always blank by default.

8. Click OK.

Creating Variables
Next you need to set up a string variable for each piece of data retrieved from 
the database. To create a variable, do the following:

1. Right-click in the Variables window and choose New Object.

2. Name the variable and select String from the Type drop-down list.

3. Click OK.

Querying Objects
PatternStream allows you to interactively create SQL queries. To create an 
SQL query, do the following:

1. Right-click in the Query Objects window and select New Object.

2. Name the query Firms and choose Select from the Query Type drop-
down list.

3. Click OK.

4. Select Simple Directory from the Connection Object drop-down list.

Figure 7 DB Connection dialog box.
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5. Click on the From tab.

6. Enter Firms in the Table Name field.

7. Click the Add Table button.

8. Click on the Select tab.

9. Select a PatternStream variable from the Variable Name drop-down 
list.

10. Enter the database column name in the Column Name field.

11. Select the Firms table from the Table Name drop-down list.

12. Click the Insert button.

Figure 8 From tab in Select Query Properties dialog box.
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1. Repeat Steps 9–12 for each 
variable and data point retrieved 
in this query.

13. Click Apply.

Figure 9 Select tab in Select Query 
Properties dialog box.
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14. Click on the View SQL tab to view your query.

15. Click OK.

Figure 10 View SQL tab in Select Query Properties dialog box.
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Creating String 
Templates

String templates are objects that allow you to publish the values stored in the 
PatternStream variables. In Figure B-6, notice that the City string template is 
made up of four variable string segments (City, State, ZipCode, and ZipCode 
[PO Box]) and three constant string segments (a comma and a space, two 
spaces, and an en dash). 

To create a string segment, do the following:

1. Select Parent>New Object under the String Templates tab.

2. Name the string template and click OK.

3. To add segments to the newly created string template, choose the 
segment type from the Segment Type drop-down list.

4. Right-click in the Segment Type window and choose Insert.

If the segment type is a variable string, do the following:

a. Double-click on the variable string’s index number.

b. Click the Select Variable button.

c. Select the PatternStream variable you wish to use.

Figure 11 String templates for City and its associated variables.
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d. Click OK.

If the segment type is a constant string, do the following:

e. Double-click on the constant string’s index number.

f. Type the static text in the String Value field, or choose the special 
character (such as an em dash, soft return, etc.) from the Special 
Character drop-down list and click the Insert Hex Code button.

g. Click OK.

5. Repeat Steps 1–5 until all the necessary string templates are created.

Building Patterns Now that you have created a data connection to the database, have created 
queries to select the data values from the database, have created variables to 
store the data, and have created string templates to output the variable values, 
you are ready to create a pattern to attach a query and paragraph targets to 
output to FrameMaker.

To create a new pattern, do the following:

1. Click on the PatternBuilder tab.

2. Select Parent>New Object.

3. Name the pattern Firms and click OK.

4. Select the new pattern.

5. Select Parent>Object Info.

6. Click the Select Query button.

7. Select the query Firms.
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8. Click OK.

Creating Paragraph Targets
Now that you have created a pattern, you need to create a target to output one 
or more of our string template values. For the Firm query and pattern, we 
need a paragraph target for FML_Number, Firm Name, TradeName, Street 
Address, City/State/Zip, and Phone Number.

To create a paragraph target, follow these steps:

1. Right-click in the right-hand window of the PatternBuilder tab and 
choose Create Target.

2. Name the paragraph target in the Name field.

3. Select Paragraph from the Target drop-down list.

4. Click OK. The Paragraph Target Properties window will open.

5. Click on the String Templates tab.

6. Click the Attach button.

Figure 12 Creating a pattern.
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7. Select the string template you want outputted in this paragraph.

8. Click Apply.

9. Click on the Setup tab.

10. Make sure the Begin New Paragraph box is checked.

11. Select from the Paragraph Format drop-down list the paragraph tag 
in FrameMaker that you wish to use.

12. Make sure the Generate Always box is checked.

Figure 13 String Templates tab in Paragraph Target Properties dialog box.
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13. Click OK.

Creating 
Conditions

A condition in PatternStream allows items to be output only if a certain 
condition or conditions are true or false. Earlier in this example you learned 
about the need to not output an en dash if a particular company did not have 
a four-digit zip code.

To create a condition, follow these steps:

1. Click on the Conditions/PLists tab.

2. Right-click in the left-hand window and select New Object.

3. Name the condition NoZip4.

4. Select Expression from the Type drop-down list.

5. Under Left Hand Side, make sure Use Literal Value is unchecked.

6. Select ZipCode (PO Box) from the Left Hand Side Variable Name 
drop-down list.

Figure 14 Setup tab in Paragraph Target Properties dialog box.
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7. Select NOT EQUAL from the Logical Operation drop-down list.

8. Make sure Use Literal Value is checked under Right Hand Side.

9. Click the Set Value button.

10. Select String and make sure the string field is blank/empty.

11. Click OK.

This condition can now be applied in the City string template on both the en 
dash and ZipCode (PO Box) segments.
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PSet View Once you have created all of the objects needed in this example, they are 
attached to each other to finish this project in PatternStream. The PSet View 
tab shows a visual representation of the entire project. This view allows you 
to see the logical order in which objects will be processed (see Figure 15). To 
output the directory from this point, just select PSET>Run in PatternStream.

Figure 15 PSet view.
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3 Data-Driven Publishing with FrameScript
FrameScript is a scripting language for FrameMaker. It has support for ODBC 
data connections and can be used for simple database publishing projects. 
Very simple database publishing/mail merge applications can be done 
effectively with FrameScript. FrameScript also communicates directly with 
any ODBC-compliant database and passes the data received directly into 
FrameMaker, where it is formatted on the fly. Although any size of project 
can theoretically be done with FrameScript, the cost in development time or 
contracting time would soon make a large project cost prohibitive, and a 
solution like PatternStream would become a better option. 
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2 Simple Directory FrameScript Code
The following FrameScript code will output the sample directory using an 
existing FrameMaker template named SimpleDirectory.fm. The code is well 
commented so you can see what each routine is doing. The logic is very 
similar to the PatternStream example you looked at earlier.
// ---------------------------------------------------
// -- User Defined Database Parameters
// -- Change to the correct values for your database
// ---------------------------------------------------
/*ODBC Connection Name */

SET vDSNName = 'PS_SimpleDirectory';

/*Database User ID */
SET vUserID = 'admin';

/*Database Password */
SET vPass = '';

/*Name of FrameMaker template */
SET v_Template = 'SimpleDirectory.fm';

// ---------------------------------------------------
// --         DO NOT EDIT BELOW THIS LINE
// ---------------------------------------------------

/*Gets the path to this script and puts it 
in a variable called v_ScriptFolderPath */

Run GetScriptPath;

/*Opens a new document based on the variable 
v_Template in the directory v_ScriptFolderPath
This script and the template must be in
the same directory to function */

Run GenerateDocument;

/*Sets and opens the datasource from which
the data will be extracted and published */

Run SetDataSource;
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// ---------------------------------------------------
/*Executes the first query that returns the FML Number, Name, 
Trade Name, Street Address, City, State, Zip+5, Zip+4, and Phone 
from the database and outputs them to FrameMaker fully formatted 
with paragraph and character format applied */
// ---------------------------------------------------

vQuery1 = 'SELECT Name, Phone, Street, FML_Number, TradeName, 
ZipCode_5Digit, ZipCode_4Digit, State, City FROM firms WHERE Name 
LIKE '+QUOTE+'amer%'+QUOTE+';';

/*Set a new EQuery object */
New EQuery NewVar(vEQuery);  

/*Set a new datasource for the EQuery object */
Set vEQuery.EDB = vDataSource;  

/*Set the query to be used for the EQuery object */
Set vEQuery.Select = vQuery1;

/*Executes the query and returns a message if no data is returned 
*/

Run vEQuery.RunQuery;
If vEQuery.NumCols = 0

Write Console 'No data was returned.    ';
EndIf

/*Loop through each record returned, format the data and output 
it to FrameMaker */

Loop While(vEQuery.AtEof = 0) LoopVar(vRecordNo) Init(1) 
Incr(1)
/*Get FML Number from database and put 'F-M-L ' in front of it 
and output using the 'FML Number' paragraph tag */

Set vFML_Number = vEQuery.Fields.FML_Number;
Set vFML_Number_Output = 'F-M-L '+vFML_Number;
RUN Generate_Output v_Value(vFML_Number_Output) 

v_Format_To_Use('FML Number');
/*Get company name from database and output using 'Firm Name' 
paragraph tag */

Set vName = vEQuery.Fields.Name;
RUN Generate_Output v_Value(vName) 

v_Format_To_Use('Firm Name');
/*Insert company name index marker */

Get Object Type(MarkerType) Name('Index') 
NewVar(vMarkerType);

Set vIndexText = vName;
SET vInsertionPoint = vCurrPgf;
New Marker NewVar(vMarker) MarkerText(vIndexText) 

MarkerTypeId(vMarkerType) 
TextLoc(vInsertionPoint);
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/*Get Trade Name from database and put a 'Trade Name ' in front 
of the trade name and output it--if it is not blank--using the 
'TradeName' paragraph tag */

Set vTradeName = vEQuery.Fields.TradeName;
Set vTradeName_Output = 'Trade Name ' + vTradeName;
If vTradeName <> ''

RUN Generate_Output v_Value(vTradeName_Output) 
v_Format_To_Use('TradeName');

EndIf
/*Get the street address and output using 'Firm Info' paragraph 
tag */

Set vStreet = vEQuery.Fields.Street;
RUN Generate_Output v_Value(vStreet) 

v_Format_To_Use('Firm Info');
/*Get the city, state, zip5, zip4.  Append values together and 
format as a single string.  Only output the hypen and zip4 if 
zip4 is not null.  Output with 'Firm Info' paragraph tag. */

Set vCity = vEQuery.Fields.City;
Set vState = vEQuery.Fields.State;
Set vZipCode_5Digit = vEQuery.Fields.ZipCode_5Digit;
Set vZipCode_4Digit = vEQuery.Fields.ZipCode_4Digit;
Set vCityStateZip = vCity + ', ' + vState + '  ' + 

vZipCode_5Digit 
If vZipCode_4Digit <> ''

Set vCityStateZip = vCityStateZip + '-' + 
vZipCode_4Digit;

EndIf
RUN Generate_Output v_Value(vCityStateZip) 

v_Format_To_Use('Firm Info');
/*Get the phone number, format it (###) ###-#### and output with 
the 'Firm Info' paragraph tag. */

Set vPhone = vEQuery.Fields.Phone;
Run ParsePhoneNum vRawNum(vEQuery.Fields.Phone) 

Returns vFormattedNum(vPhone);
Set vPhone_Output = 'Phone ' + vPhone;
RUN Generate_Output v_Value(vPhone_Output) 

v_Format_To_Use('Firm Info');
/*Get the next record in the database. */

vEQuery.GetNext;

// ---------------------------------------------------
/*Executes the second query that is nested within the first query 
so that the executives and his/her titles can be output for each 
company.  This query returns the executive name and title from 
the database and outputs them to FrameMaker fully formatted with 
paragraph and character formats applied */
// ---------------------------------------------------

vQuery2 = 'SELECT exec, title FROM executives WHERE 
FML_Number =  '+QUOTE+vFML_Number+QUOTE+' ORDER BY seq';
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/* See the first query for detailed comments */
New EDB DataSource(vDSNName) NewVar(vDataSource2) 

User(vUserID) Password(vPass);
Run vDataSource2.Open;
New EQuery NewVar(vEQuery2);
Set vEQuery2.EDB = vDataSource2;
Set vEQuery2.Select = vQuery2;

Run vEQuery2.RunQuery;
If vEQuery2.NumCols = 0

Write Console 'No data was returned.    ';
EndIf

Loop While(vEQuery2.AtEof = 0)
/*Get the executive name and title and output using the 'Exec' 
paragraph tag. Only output a tab character at title if the title 
exists. */

Set vExec = vEQuery2.Fields.exec;
Set vExecTitle = vEQuery2.Fields.title;
If vExecTitle <> ''

Set vExec_Title = vExec + CHARTAB + vExecTitle;
RUN Generate_Output v_Value(vExec_Title) 

v_Format_To_Use('Exec');
EndIf

vEQuery2.GetNext;
EndLoop

/* Close the second query and datasource.  Delete the objects for 
each */

Run vEQuery2.Close;
Delete Object(vEquery2);
Run vDataSource2.Close;
Delete Object(vDataSource2);

// ---------------------------------------------------
/*Executes the third query that is nested within the first query 
so that the SIC numbers can be output for each company.  This 
query returns the SIC number(s) from the database and outputs 
them to FrameMaker fully formatted with paragraph and character 
formats applied */
// ---------------------------------------------------

vQuery3 = 'SELECT DISTINCT sic FROM sic_numbers WHERE 
FML_Number = '+QUOTE+vFML_Number+QUOTE;

New EDB DataSource(vDSNName) NewVar(vDataSource3) 
User(vUserID) Password(vPass);

Run vDataSource3.Open;

New EQuery NewVar(vEQuery3);
Set vEQuery3.EDB = vDataSource3;
Set vEQuery3.Select = vQuery3;
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Run vEQuery3.RunQuery;
If vEQuery3.NumCols = 0

Write Console 'No data was returned.    ';
EndIf

Loop While(vEQuery3.AtEof = 0) LoopVar(vRecordNo3) Init(1) 
Incr(1)
/*Get the SIC number(s) from the database.  Store the first 
number with a 'SIC ' in front of it. Append each subsequent 
number(s) and place a ', ' between each. Store the final value 
for output in the fourth query. */

Set vSic = vEQuery3.Fields.sic;
If vSic <> ''

If vRecordNo3 =1
Set vSic_Output = 'SIC ' + vSic;

Else
Set vSic_Output = vSic_Output + ', ' + vSic;

EndIf
EndIf

vEQuery3.GetNext;

// ---------------------------------------------------
/*Executes the fourth query that is nested within the first query 
so that the SIC description(s) can be output for each company.  
This query returns the SIC description(s) from the database and 
outputs them to FrameMaker fully formatted with paragraph and 
character formats applied */
// ---------------------------------------------------

vQuery4 = 'SELECT descr FROM sic_numbers WHERE  ( FML_Number 
=  '+QUOTE+vFML_Number+QUOTE+' and SIC = '+QUOTE+vSIC+QUOTE+')';

/* See the first query for detailed comments */
New EDB DataSource(vDSNName) NewVar(vDataSource4) 

User(vUserID) Password(vPass);
Run vDataSource4.Open;
New EQuery NewVar(vEQuery4);
Set vEQuery4.EDB = vDataSource4;
Set vEQuery4.Select = vQuery4;
Run vEQuery4.RunQuery;
If vEQuery4.NumCols = 0

Write Console 'No data was returned.    ';
EndIf

Loop While(vEQuery4.AtEof = 0) LoopVar(vRecordNo4) Init(1) 
Incr(1)
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/*Get the SIC description(s) from the database.  Store the first 
description and append each subsequent number(s) and place a '; ' 
between each. Place a '.' at the end of the string.  Store for 
output. */

Set vDescr = vEQuery4.Fields.descr;
If vDescr_Output <> ''

If vRecordNo4 = 1
Set vDescr_Output = vDescr;

Else
Set vDescr_Output = vDescr_Output + '; ' + 

vDescr;
EndIf

EndIf
vEQuery4.GetNext;

EndLoop
If vDescr_Final = '0'

Set vDescr_Final = '';
EndIf
If vDescr_Final = ''

Set vDescr_Final = vDescr_Output;
Else

Set vDescr_Final = vDescr_Final + '; ' + 
vDescr_Output;

EndIf
/*End Query 4 */
// Close and delete the data source.

Run vEQuery4.Close;
Delete Object(vEquery4);

// Close and delete the data source.
Run vDataSource4.Close;
Delete Object(vDataSource4);

/*End Query 3 */
EndLoop

// Close and delete the query object.
Run vEQuery3.Close;
Delete Object(vEquery3);

// Close and delete the data source.
Run vDataSource3.Close;
Delete Object(vDataSource3);

/*Prepend the SIC variable to the description variable and output 
using 'Firm Info' paragraph tag. */

Set vSic_Descr_Output = vSic_Output + ': ' + vDescr_Final + 
'.';

RUN Generate_Output v_Value('') v_Format_To_Use('Firm 
Info');

RUN Generate_Output v_Value(vSic_Descr_Output) 
v_Format_To_Use('Firm Info');

Set vSic_Output = '';
Set vDescr_Final = '';
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/*Insert company name header/footer $1 marker */
Get Object Type(MarkerType) Name('Header/Footer $1') 

NewVar(vMarkerType);
Set vMarkerText = vName;
SET vInsertionPoint = vCurrPgf;
New Marker NewVar(vMarker) MarkerText(vMarkerText) 

MarkerTypeId(vMarkerType) TextLoc(vInsertionPoint);

/* End Query 2 */
EndLoop

// Close and delete the query object.
Run vEQuery.Close;
Delete Object(vEquery);

// Close and delete the data source.
Run vDataSource.Close;
Delete Object(vDataSource);

// ---------------------------------------------------
SUB GetScriptPath

FIND DIRSEP InString(ThisScript) Back  ReturnPos(ColonPos) 
ReturnStatus(ColonFound);

IF ColonFound 
GET String FromString(ThisScript) EndPos(ColonPos)  

NewVar(v_ScriptFolderPath);
ELSE

SET v_ScriptFolderPath = ThisScript;
ENDIF

ENDSUB
// ---------------------------------------------------

// ---------------------------------------------------
SUB GenerateDocument

NEW Document Template (v_ScriptFolderPath+v_Template) 
NewVar(v_NewDoc);

SET currPgf = v_NewDoc.MainFlowInDoc;
ENDSUB
// ---------------------------------------------------

// ---------------------------------------------------
SUB SetDataSource

Set ErrorCode = 0;
New EDB DataSource(vDSNName) NewVar(vDataSource) 

User(vUserID) Password(vPass);
If ErrorCode not= 0

MsgBox 'Error on DB create ('+ErrorCode+') Msg-
'+ErrorMsg;

LeaveSub;
EndIf
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// Attempt to open the database.
Set ErrorCode = 0;
Run vDataSource.Open;
If vDataSource.ErrorCode not= 0

MsgBox 'The datasource '+vDsnName+' could not be opened.    
'+CHARLF+CHARLF+

'Database error code: 
'+vDataSource.ErrorCode+CHARLF+

'Database error message: 
'+vDataSource.ODBCError+'    '

Mode(Warn);
// If the database could not be opened, set an error code.

Set ErrorCode = -1;
EndIf

ENDSUB
// ---------------------------------------------------

// ---------------------------------------------------
SUB Generate_Output

SET vWritePgf = vCurrPgf;
NEW Paragraph NewVar(CurrPgfNew) PrevObject(vWritePgf);
SET vWritePgf = CurrPgfNew;
GET String FromString(v_Value) NewVar(v_Output) 

ReplaceAll(CHARLF) With(' ')
ReplaceAll(CHARCR) With(' '); 

NEW Text Object(vWritePgf) v_Output;

//Format paragraph style according to v_Format_To_Use
GET Object Type(PgfFmt) Name(v_Format_To_Use) 

NewVar(vBodyFmt);
SET vWritePgf.Properties = vBodyFmt.Properties;
SET vCurrPgf = vWritePgf;

ENDSUB
// ---------------------------------------------------

// ---------------------------------------------------
SUB ParsePhoneNum

Local vAreaCode;
Local vExchange;
Local vNumber;
If vRawNum.Size = 10

Get String FromString(vRawNum) EndPos(3) 
NewVar(vAreaCode);

Get String FromString(vRawNum) StartPos(4) EndPos(6) 
NewVar(vExchange);

Get String FromString(vRawNum) StartPos(7) 
NewVar(vNumber);

Set vFormattedNum = '(' + vAreaCode + ') ' + vExchange + 
'-' + vNumber;

Else
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Set vFormattedNum = vRawNum;
EndIf

//
ENDSUB
// ---------------------------------------------------
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4 Automated Publishing with MML
MML is short for Maker Markup Language. MML is a very simple “tagging” 
structure that allows text files to be mapped to the formats of a FrameMaker 
template. This method of automated publishing is best used for a very simple 
layout. MML can only contain paragraph and character formats. If tables are 
necessary in the output, MML will not suffice.

As with any markup language, time and support will need to come from the 
IT department (or whoever maintains the database). The markup will need 
to be added as the data is exported from the database and written out to the 
MML text file. Below is a sample MML file for the directory sample used in 
this discussion. The MML assumes that an existing FrameMaker template 
exists, with the formats defined. To view the process of setting up a query or a 
set of queries to output MML from a database, see Sample SQL Query that 
Returns MML Syntax on page 48. 

After the query is run to add the MML markup to the data, the data can be 
saved as a text file from Access (or you can add further code to export it 
automatically). The resulting MML file can then be imported into your 
FrameMaker template. The MML tags “map” to the paragraph and character 
formats in your template. MML supports only paragraph and character 
formats, so it is only a valid option for database publishing the simplest 
projects.

FrameMaker is shipped with a complete MML reference guide in PDF 
format. This guide is located in the FrameMaker install directory in a 
subdirectory called OnlineManuals:
Adobe FrameMaker7.0\OnlineManuals\MML_Reference.pdf

FrameMaker is also shipped with a complete set of sample MML files. They 
are located in the FrameMaker install directory in a directory called Samples:
Adobe FrameMaker7.0\Samples\MML\
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2 Sample SQL Query that Returns MML Syntax
The following SQL statement demonstrates the method of “wrapping” MML 
markup code around data elements for importing into an existing 
FrameMaker template. This particular SQL statement outputs the necessary 
MML markup for each firm.

SELECT "<FML\ Number><Emphasis>F-M-L <Default Para 
Font>"+FML_Number, 
"<Firm\ Name>"+Name, 
"<Marker <MType 2> <MText '"+Name+"'> >",
"<TradeName>"+TradeName,
"<Firm\ Info>"+Street, 
"<Firm\ Info>"+City+", "+State+"  "+ZipCode_5Digit+"-
"+ZipCode_4Digit,
"<Firm\ Info><Emphasis>Phone: <Default Para Font> ("+ 
left(Phone,3)+") "+mid(Phone,4,3)+"-"+right(Phone,4)
FROM firms;

Directory Entry in 
MML Format

The following code contains the MML markup for a single entry in the 
directory:
<FML\ Number>F-M-L 066778077
<Firm\ Name>AMERICAN ASSOCIATION OF RETIRED PERSONS
<Marker <MType 2> <MText `AMERICAN ASSOCIATION OF RETIRED 
PERSONS'> >
<TradeName>Trade Name AARP
<Firm\ Info>601 E St Nw
<Firm\ Info>Washington, DC 20049–0001
<Firm\ Info>Phone (202)-434-2277
<Exec>Norman Stengel\tPr
<Exec>Richard Henry\tCOO
<Exec>Clifford J Rose\tCont
<Exec>Steven S Zaleznick\tGC
<Exec>Horace B Deets\tEx Dir
<Exec>James R Holland\tCommctns
<Exec>James A Maigret\tFin Plng
<Exec>Charles W Allen\tPubls
<Exec>Constance Swank\tRsch
<Exec>Thomas C Nelson\tSvcs

d
Keep in mind that the syntax returned by this query is correct MML syntax. However, 
all of the logic that puts the entries together is missing. You would either have to pre- 
or post-process the MML file to correctly link the executives in the directory or handle 
the SIC numbers and descriptions. This will further add to the complexity of using 
markup such as this.
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<Exec>Wayne F Haefer\tDir
<Exec>C Anne Harvey\tDir
<Exec>Mary Anne Riesenberg\tDir
<Exec>Johc C Rother\tDir
<Exec>Jan Stefanov\tDir
<Firm\ Info>\rSIC 8399: health systems agency; social change 
association; social service information exchange.
<Marker <MType 0> <MText `AMERICAN ASSOCIATION OF RETIRED 
PERSONS'> >
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4 Automated Publishing with XML
XML stands for eXtensible Markup Language. This markup is more complex 
than MML and requires opening and closing tags. This section will only deal 
with XML as it relates to database publishing. To view the process of setting 
up a query or a set of queries to output XML from a database, see Sample 
SQL Query that Returns XML Syntax on page 51.

XML is becoming the standard for data exchange. Using a markup language 
such as XML can be a reasonable method of database publishing. Keep in 
mind that the XML generated by the database will need to be valid XML. A 
structured FrameMaker template and application will then need to be created 
in order for FrameMaker to be able to import the XML and format it.

FrameMaker 7 is shipped with a complete XML cookbook in PDF format. 
The PDF file is located in the FrameMaker install directory in a directory 
called XMLCookbook. This cookbook and sample files demonstrate how to 
import and export valid XML in FrameMaker:
Adobe FrameMaker7.0\XMLCookbook\UserGuide.pdf
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2 Sample SQL Query that Returns XML Syntax
The following SQL statement demonstrates the method of “wrapping” XML 
markup code around data elements for importing into an existing 
FrameMaker template. This particular SQL statement outputs the necessary 
XML markup for each firm. The SQL is executed within Access to return data 
wrapped in XML. Access 2002 and other more recent database applications 
allow for direct XML export of data.

SELECT "<FML-Number><Emphasis>F-M-L 
</Emphasis>"+FML_Number+"</FML-Number>", 
"<Firm-Name>"+Name+"</Firm-Name>", 
"<TradeName>"+TradeName+"</TradeName>",
"<Firm-Info>"+Street+"</Firm-Info>", 
"<Firm-Info>"+City+", "+State+"  "+ZipCode_5Digit+"-
"+ZipCode_4Digit+"</Firm-Info>",
"<Firm-Info><Emphasis>Phone: </Emphasis> ("+ left(Phone,3)+") 
"+mid(Phone,4,3)+"-"+right(Phone,4)+"</Firm-Info>"
FROM firms;

Directory Entry in 
XML Format

The following code contains the final XML markup for a single entry in the 
directory:
<FML-Number><Emphasis>F-M-L </Emphasis>066778077</FML-Number>
<Firm-Name>AMERICAN ASSOCIATION OF RETIRED PERSONS</Firm-Name>
<TradeName>Trade Name <TradeName>AARP</TradeName></TradeName>
<Firm-Info>601 E St Nw</Firm-Info>
<Firm-Info>Washington, DC 20049-0001</Firm-Info>
<Firm-Info><Emphasis>Phone </Emphasis>(202)-434-2277</Firm-Info>
<Exec>Norman StengelPr</Exec>
<Exec>Richard HenryCOO</Exec>
<Exec>Clifford J RoseCont</Exec>
<Exec>Steven S ZaleznickGC</Exec>
<Exec>Horace B DeetsEx Dir</Exec>
<Exec>James R HollandCommctns</Exec>
<Exec>James A MaigretFin Plng</Exec>
<Exec>Charles W AllenPubls</Exec>
<Exec>Constance SwankRsch</Exec>
<Exec>Thomas C NelsonSvcs</Exec>

d
Keep in mind that the syntax returned by this query is correct XML syntax. However, all 
of the logic that puts the entries together is missing. You would either have to pre- or 
post-process the XML file to correctly link the executives in the directory or handle the 
SIC numbers and descriptions. This will further add to the complexity of using markup 
such as this.
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<Exec>Wayne F HaeferDir</Exec>
<Exec>C Anne HarveyDir</Exec>
<Exec>Mary Anne RiesenbergDir</Exec>
<Exec>Johc C RotherDir</Exec>
<Exec>Jan StefanovDir</Exec>
<Firm-Info><Emphasis></Emphasis></Firm-Info>
<Firm-Info><Emphasis>SIC </Emphasis><SIC-NUMBER>8399</SIC-
NUMBER>: health systems agency; social change association; social 
service information exchange.</Firm-Info>
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4 Automated Publishing with MIF
Maker Interchange Format (MIF) is the ASCII version of a FrameMaker file. 
When saving a FrameMaker document, FrameMaker usually saves the file in 
a proprietary binary format that only FrameMaker can understand. When 
saving a FrameMaker document as a MIF file, FrameMaker encodes the 
document in markup and saves it in ASCII format. The markup is very 
complex and can support any feature/function of FrameMaker. This markup 
can be used by other programs to create FrameMaker files.

When you do database publishing with MIF, the MIF syntax is wrapped 
around the data elements. A very large text (ASCII) file is then generated 
from the database and then is subsequently opened or imported into the final 
FrameMaker template. MIF files are very verbose and can be difficult to read 
and troubleshoot. MIF can be combined with MML to make the files easier to 
read and understand. To view the process of setting up a query or set of 
queries to output MIF from a database, see Sample SQL Query that Returns 
XML Syntax on page 51.

By using MIF in database publishing, you can create a document almost as 
complex as if you had taken a data-driven approach, with a few exceptions. 
Because any feature in FrameMaker has an equivalent in MIF, the entire 
document (including the template) can be generated automatically from the 
database. The biggest drawback to this solution is the time required (almost 
all of it on the database end) to create the SQL to generate the initial MIF 
syntax. Refering to Sample SQL Query that Returns MIF Syntax on 
page 54, notice the amount of syntax required just for a simple entry in the 
directory.

FrameMaker is shipped with a complete MIF reference guide in PDF format. 
The PDF file is located in the FrameMaker install directory in a directory 
called OnlineManuals:
Adobe FrameMaker7.0\OnlineManuals\MIF_Reference.pdf

FrameMaker is also shipped with a complete set of sample MIF files. They are 
located in the FrameMaker install directory in a directory called Samples:
Adobe FrameMaker7.0\Samples\MIF\
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2 Sample SQL Query that Returns MIF Syntax
The following SQL statement demonstrates the method of “wrapping” MIF 
markup code around data elements for importing into an existing 
FrameMaker template. This particular SQL statement outputs the necessary 
MIF markup for each firm.

SELECT
"<Para <PgfTag 'FML Number'><ParaLine <Font <FTag 'Emphasis'> > 
<String 'F-M-L '> <Font <FTag ''> > <String '"+FML_Number+"'> > 
>",
"<Para <PgfTag `Firm Name'><ParaLine <String `"+Name+"'> >",
"<Marker <MType 2> <MTypeName `Index'> <MText `"+Name+"'> 
<MCurrPage `1'> > >",
"<Para <PgfTag ̀ TradeName'> <ParaLine <String ̀ Trade Name'> <Char 
EmSpace> <Font <FTag `TradeName'> > <String `"+TradeName+"'> > 
>",
"<Para <PgfTag ̀ Firm Info'> <ParaLine <String ̀ "+Street+"'> > >",  
"<Para <PgfTag `Firm Info'> <ParaLine <String `"+City+", 
"+State"'> <Char EnSpace> <String `"+ZipCode_5Digit+"'> <Char 
EnDash> <String `"+ZipCode_4Digit+"'> > >,
"<Para <PgfTag `Firm Info'>  <ParaLine <Font <FTag `Emphasis'> 
<FLocked No> > <String `Phone'> <Char EnSpace> <Font <FTag `'> 
<FLocked No> > <String `("+ left(Phone,3)+") "+mid(Phone,4,3)+"-
"+right(Phone,4)+"'>  >  > 
FROM firms;

Directory Entry in 
MIF Format

The following code contains the MIF markup for a single entry in the 
directory:
<Para 
  <PgfTag `FML Number'>
  <ParaLine 
   <Font 
    <FTag `Emphasis'>
    <FLocked No>
   > # end of Font
   <String `F-M-L '>
   <Font 
    <FTag `'>

d
Keep in mind that the syntax returned by this query is correct MIF syntax. However, all 
of the logic that puts the entries together is missing. You would either have to pre- or 
post-process the MIF file to correctly link the executives in the directory or handle the 
SIC numbers and descriptions. This will further add to the complexity of using markup 
such as this.
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    <FLocked No>
   > # end of Font
   <String `066778077'>
  > # end of ParaLine
 > # end of Para
 <Para 
  <PgfTag `Firm Name'>
  <PgfReferenced Yes>
  <ParaLine 
   <String `AMERICAN ASSOCIATION OF RETIRED '>
  > # end of ParaLine
  <ParaLine 
   <String `PERSONS'>
   <Marker 
    <MType 2>
    <MTypeName `Index'>
    <MText ` AMERICAN ASSOCIATION OF RETIRED PERSONS '>
    <MCurrPage `1'>
   > # end of Marker
  > # end of ParaLine
 > # end of Para
 <Para 
  <PgfTag `TradeName'>
  <ParaLine 
   <String `Trade Name'>
   <Char EmSpace>
   <Font 
    <FTag `TradeName'>
    <FLocked No>
   > # end of Font
   <String `AARP'>
  > # end of ParaLine
 > # end of Para
 <Para 
  <PgfTag `Firm Info'>
  <ParaLine 
   <String `601 E St Nw'>
  > # end of ParaLine
 > # end of Para
 <Para 
  <PgfTag `Firm Info'>
  <ParaLine 
   <String `Washington, DC'>
   <Char EnSpace>
   <String `20049'>
   <Char EnDash>
   <String `0001'>
  > # end of ParaLine
 > # end of Para
 <Para 
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  <PgfTag `Firm Info'>
  <ParaLine 
   <Font 
    <FTag `Emphasis'>
    <FLocked No>
   > # end of Font
   <String `Phone'>
   <Char EnSpace>
   <Font 
    <FTag `'>
    <FLocked No>
   > # end of Font
   <String `(202)-434-2277'>
  > # end of ParaLine
 > # end of Para
 <Para 
  <PgfTag `Exec'>
  <ParaLine 
   <String `Norman Stengel'>
   <Char Tab>
   <String `Pr'>
  > # end of ParaLine
 > # end of Para
 <Para 
  <PgfTag `Exec'>
  <ParaLine 
   <String `Richard Henry'>
   <Char Tab>
   <String `COO'>
  > # end of ParaLine
 > # end of Para
 <Para 
  <PgfTag `Exec'>
  <ParaLine 
   <String `Clifford J Rose'>
   <Char Tab>
   <String `Cont'>
  > # end of ParaLine
 > # end of Para
 <Para 
  <PgfTag `Exec'>
  <ParaLine 
   <String `Steven S Zaleznick'>
   <Char Tab>
   <String `GC'>
  > # end of ParaLine
 > # end of Para
 <Para 
  <PgfTag `Exec'>
  <ParaLine 
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   <String `Horace B Deets'>
   <Char Tab>
   <String `Ex Dir'>
  > # end of ParaLine
 > # end of Para
 <Para 
  <PgfTag `Exec'>
  <ParaLine 
   <String `James R Holland'>
   <Char Tab>
   <String `Commctns'>
  > # end of ParaLine
 > # end of Para
 <Para 
  <PgfTag `Exec'>
  <ParaLine 
   <String `James A Maigret'>
   <Char Tab>
   <String `Fin Plng'>
  > # end of ParaLine
 > # end of Para
 <Para 
  <PgfTag `Exec'>
  <ParaLine 
   <String `Charles W Allen'>
   <Char Tab>
   <String `Publs'>
  > # end of ParaLine
 > # end of Para
 <Para 
  <PgfTag `Exec'>
  <ParaLine 
   <String `Constance Swank'>
   <Char Tab>
   <String `Rsch'>
  > # end of ParaLine
 > # end of Para
 <Para 
  <PgfTag `Exec'>
  <ParaLine 
   <String `Thomas C Nelson'>
   <Char Tab>
   <String `Svcs'>
  > # end of ParaLine
 > # end of Para
 <Para 
  <PgfTag `Exec'>
  <ParaLine 
   <String `Wayne F Haefer'>
   <Char Tab>
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   <String `Dir'>
  > # end of ParaLine
 > # end of Para
 <Para 
  <PgfTag `Exec'>
  <ParaLine 
   <String `C Anne Harvey'>
   <Char Tab>
   <String `Dir'>
  > # end of ParaLine
 > # end of Para
 <Para 
  <PgfTag `Exec'>
  <ParaLine 
   <String `Mary Anne Riesenberg'>
   <Char Tab>
   <String `Dir'>
  > # end of ParaLine
 > # end of Para
 <Para 
  <PgfTag `Exec'>
  <ParaLine 
   <String `Johc C Rother'>
   <Char Tab>
   <String `Dir'>
  > # end of ParaLine
 > # end of Para
 <Para 
  <PgfTag `Exec'>
  <ParaLine 
   <String `Jan Stefanov'>
   <Char Tab>
   <String `Dir'>
  > # end of ParaLine
 > # end of Para
 <Para 
  <PgfTag `Firm Info'>
  <ParaLine 
   <Font 
    <FTag `Emphasis'>
    <FLocked No>
   > # end of Font
  > # end of ParaLine
 > # end of Para
 <Para 
  <PgfTag `Firm Info'>
  <PgfReferenced Yes>
  <ParaLine 
   <Font 
    <FTag `Emphasis'>
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    <FLocked No>
   > # end of Font
   <String `SIC'>
   <Char EnSpace>
   <Font 
    <FTag `SIC NUMBER'>
    <FLocked No>
   > # end of Font
   <String `8399'>
   <Font 
    <FTag `'>
    <FLocked No>
   > # end of Font
   <String `: health systems agency; social change association; 
'>
  > # end of ParaLine
  <ParaLine 
   <String `social service information exchange.'>
   <Marker 
    <MType 0>
    <MTypeName `Header/Footer $1'>
    <MText `AMERICAN ASSOCIATION OF RETIRED PERSONS'>
    <MCurrPage `1'>
   > # end of Marker
  > # end of ParaLine
 > # end of Para
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1 Summary 
Database publishing is an emerging marketplace. Many applications can be 
used to publish information from one or more databases and static files with 
FrameMaker. The example given in this chapter was very simple in order to 
better explain the different methods and applications that can be used. 
Obviously, much more complex publications can be generated by some of 
these tools.

The reason the author tends to favor a more data-driven approach like 
PatternStream or FrameScript is because the formatting is done at the same 
time. As I acquire data from the database, I can literally watch the data get 
formatted on the screen. When using a markup language, I must first export 
the data as valid XML and then set up a structured FrameMaker template and 
application to read the XML in and format it. The time spent creating the 
valid XML and structured FrameMaker template is generally more than is 
required in the data-driven approach. Changing the design is also much 
faster in the data-driven approach.

Visit the websites listed in the section Database Publishing Applications on 
page 4 to request a demo version of these applications to see which product 
might best suit your specific needs. The author would also be happy to 
answer any questions you may have regarding getting started in database 
publishing. Drop Brad Anderson a message or send feedback with the form 
on the last page of this PDF.
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1 Send Feedback
First Name Last Name

Company Name

Address

City State Postal Code

Country

Email Address

URL (Website Address)

Comments/Feedback
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